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1. Introduction to ZaraStudio
ZaraStudio is an automation system for playing and managing the audio of a radio
station, though it can be used too in any other scenario with similar requirements.
It is designed with small and medium-sized radio stations in mind, though it can be
used in bigger radio stations too without any problems. Broadcasting programs at
certain times or random musical selections are extremely easy tasks with ZaraStudio.
With it, you will be able to leave your station automated during long periods, like
summer. Besides, if your station is affiliated to a radio network, you will be able to
automate local disconnections for ads, as long as the 'mother station' uses a
telecommand system, either through contacts on the computer parallel port or
through DTMF tones.
In contrast to other programs, ZaraStudio does not rely on a database or a server to
work. It doesn't need special sound cards either, since it works with any Windowscompatible card, though it is recommended to use professional cards to get an
optimal audio quality.
Furthermore, ZaraStudio requires few resources and it can work with a minimum
hardware. As for the operating system, it is designed to be used in Windows XP, Vista
or 7 (the contact closure detection through the parallel port feature is only available
on 32-bit systems).

2. The first execution
When executing ZaraStudio the first time, you might get an error message,
depending on your operating system. The most common cases are:
●

An error that says a DLL file is not found. ZaraStudio relies on Windows
Media Player to play WMA and MP3 files. If you get this error, then you should
update that program to the latest version available for your system, or install
a package with the files needed (http://www.zarastudio.es/files/wmfdist.exe).

●

An error about a file called IO.SYS. You will get this error only in Windows
Vista. If this is your case, close ZaraStudio and run it with an administrator
account. After that execution, the error message shouldn't appear anymore,
even if you use limited accounts.

Default user
When executing the application the first time, you will see that some features are
disabled. This is because the system opens with a limited user account by default. In
order to be able to use all the modules, go to Tools > Change user and access with the
administrator account, whose user name and password is “admin”.
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3. The main window
ZaraStudio main window looks like this:

All the panels of the window can be moved and anchored in the position you prefer,
except the Events and indicators one. To do that, click with the left mouse button on
the top title bar of a panel and, without releasing the mouse button, move it around
the different window areas. You will see that some blue boxes will appear. If you
release the mouse button, the panel will be anchored at the position marked by the
blue box. This way, you can customize the look of ZaraStudio, to fit your needs and
work more comfortably. You can also hide or show some parts of the window from
the View menu, to have more space on low screen resolutions.
The main window is divided in several parts:
● Menu bar

It allows you to access to several features of the program. An important point
to note is that it only affects to the main player. To get more information, see
the section The menu bar.
● Top tool bar

It allows to search audios in a given folder and all its
subfolders. The search reads the ID3 tags TITLE and
ARTIST and, of course, the name of the file. To get more
5
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information, go to the section search in folders.
Opens the mixer application specified in the options
dialog.
Mutes or enables the sound card line in port specified
set as 'Channel 1' in the options dialog. When it is
pressed, it rebroadcasts the audio in the line in port.
Mutes or enables the sound card line in port specified
set as 'Channel 2' in the options dialog. When it is
pressed, it rebroadcasts the audio in the line in port.
Enables or disables voice tracking. When it is disabled,
voice tracking files are not played.
Opens the options dialog.
Shows or hides the auxiliary players. They work even if
they are hidden, that is, the audios in the playlist are
still played in that case.
It opens the About dialog, which contains the program
licence, information about the author of the program
and several credits.
● Players

The players are the most important part of ZaraStudio. They are the main tool
for audio playing, either manually or automatically.
● Events and indicators

This part of the window shows several indicators with the date and the time
and, optionally, the current weather conditions. In order to view this last
information, it is necessary to have an Internet connection and an auxiliary
application, which is specified later.
On the other hand, we also find access to the events module in this panel,
which is the tools that allows to automate your station, based on concrete
dates and times.
Finally, it has a file tree of or whole machine, that lets you access quickly any
audio, either to prelisten it or to broadcast it through a player.
● Jingles palette

It lets you play up to 90 jingles. See The jingles palette for more details.
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4. The players
The players allows you to broadcast audios through the specified sound card, which is
configurable by accessing the options dialog. It contains several elements:
●

The top toolbar.

●

The audio state indicators.

●

The playlist.

●

The control buttons.

The tool bar

Displays a pop-up menu with the following options:
•
New: Creates a new playlist and closes the previous one.
•
Open: Opens a previously saved playlist (LST, ROT,
SEQ...).
•
Open template: Allows to load a music style template in
the player. Songs will be added automatically to the
playlist following the template.
•
Save: Saves the current playlist.
•
Save as: Saves the current playlist with another name.
Allows you to add new audios to the list. The arrow at the right
of the plus symbol opens a context menu, that lets you add
commands to the playlist.
7
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Deletes the selected elements.
Undo the last operation done in the playlist.
Redo the last operation.
Copy the selected items into the clipboard.
Paste the clipboard contents in the playlist.
Displays a pop-up menu with the following options:
•
Find: Allows you to search audios in the playlist.
•
Check: Scans through all the playlist items and checks if
they exist on the hard disk. If there are files missing, it
tells you what files are and lets you delete them.
•
Update lengths: Updates the durations that are
displayed in the second playlist column. This command is
useful when the audios are modified and their duration
changes.
•
Shuffle: Rearranges the playlist randomly.
Changes the playing mode. It can be Manual, Normal, Repeat,
Random or Shuffle. See the playlist section for more details.

State indicators

●

Remaining time. Shows the time left until the audio which is being
played finishes.

●

Vumeter. Shows the audio level.

●

End time. Displays the end time of the audio that is being played.
Please, note that this is not an accurate data, as the overlap between
files is not considered.

●

Position track bar. Displays the percentage of the audio that has
been played. It can be moved with the mouse to play an exact part of
the file.

●

List length. Displays the length of all the files in the playlist. Please,
note that this is not an accurate data, as it does not consider the
overlap between cuts nor the length of certain files, like rotations or
random tracks.

●

List remaining. Displays the total duration of all the files that has not
been played yet, i.e., what is left in the currently being played cut plus
the length of the following ones.
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The playlist

The playlist is the main element of ZaraStudio. It shows the sequence of sound files
and/or commands which are played or executed one by one. The elements that can
appear in the list are:
● Sound Files. Currently, ZaraStudio supports the following formats:


WAV. Losless and uncompressed audio format.



MP2. Sound format that produces better quality than MP3 when using
high bitrates (more than 256 kbps). This is the standard format in
broadcasting, though is losing ground in favor of MP3.



MP3. Popular audio format for home use. ZaraStudio accepts any bitrate (constant bit-rate or variable). When using constant bitrates, it is
advised to use a minimum of 192 kbps, being recommendable to use
256 kbps to get a perfect broadcast audio quality.



OGG. A free sound file, alternative to MP3.



WMA. A Windows Media sound file. It is also an alternative to MP3.



FLAC. Losless audio format, as WAV files. However, it does compress
the audio, so it produces smaller files than WAV, though it does not
compress as much as MP3.

● Playlists (.lst, .m3u and .pls files). This file is a command when it appears

inside a list. Its purpose is to load a new list and close the previous one. The
new list will begin to play, beginning with the first song. PLS lists remember
the latest file played when opening them.

These three formats are the same for ZaraStudio. The only slightly
different one is PLS, as it remembers the last played song after opening
the list. This feature is useful to change the musical programming at a
certain time, by scheduling a file of one of these formats through an
event.
● Rotations (.rot files). A list of sound files in rotation. It contains a list of
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tracks which play in the sequence as created. The tracks repeat in sequence.
If a file in the list fails to play, the sequence will continue to the next file
(failures noted in log file). The rotation file can contain any type of track (wav,
mp3, commands, rotations...).
● Sequences (.seq files). Sequences sound files. It contains a list of tracks

that play all followed when playing the sequence. Like the rotations, the
sequences can contain any type of tracks. They can be used to program
advertising blocks.

● Templates (.tpl files). Contain the definition of a music style based on

random tracks. When a template is loaded, ZaraStudio adds audios to the
playlist automatically as the player approaches to the end, following the
guidelines specified by the template, so that there are always at least 15
audio minutes left to play.
● Stop command (.stop files). Command that stops the playback.
● Play command (.play files). Starts the playlist. It only makes sense as an

immediate event.
● Humidity files (.humidity). A sound file that says the humidity. In order to

carry out this task, it is necessary to have the files with the proper name
format in the Humidity directory, located in the folder where ZaraStudio is
installed. The format of the files must be HUMXXX.mp3, where XXX is the
corresponding humidity. For example, HUM100.mp3 is an audio clip that states:
“the current humidity is 100%”.

● Temperature files (.temperature). A sound file that says the temperature.

In order to carry out this task, it is necessary to have the files with the proper
name format in the Temperature directory, located in the folder where
ZaraStudio is installed. The format of the files must be:


TMPXXX.mp3. This is a file that contains the audio clip for temperature
XXX. For example, TMP025.mp3 is an audio clip that will say “25
degrees”.



TMPNXXX.mp3. This is a file that contains the audio clip for temperature
XXX below zero. For example, TMPN003.mp3 is an audio clip that will say
“3 degrees below zero”.

● Time announcements (.time files). A sound file that says the time. Audio

clips for hours and minutes must be properly located in the Time folder. The
name of the files must be:

1. MINXX.mp3. This is an audio clip of minute XX. For example, MIN01.mp3
will contain and audio that will say “one”.
2. HRSXX.mp3. This is an audio clip of hour XX. For example, HRS18.mp3
will contain and audio that will say “it's eighteen hours”.
3. HRSXX_O.MP3. This is an audio clip of hour XX o'clock. For example,

10

User manual

ZaraStudio
HRS18_O.MP3 will contain and audio that will say “it's six o'clock”.
● Pauses (.pause files). When playing, they cause a silence of a determined

length. In order to create pauses it is necessary to execute the command
playlist > Add pause.... Its duration must be specified between 0 and 3600
seconds.
● Random tracks (.dir files). When played, a track is selected at random from

the directory or sub-directory thereof specified. Random tracks have a system
to avoid repetitions (see Options – Random tracks for more details). In order
to create random tracks it is necessary to execute the command Playlist > Add

random track..., which is in the pop up menu of the button

from each
player. If new files are added to the specified directory, they are automatically
added to the random list.

This feature is useful to create random music programmings. A list in
repeat mode can be created with several random tracks, that will define
the random programming template.
It is recommended to use this feature only in local folders in the computer
which ZaraStudio is being executed, avoiding folders placed in other
machines of the local network. Besides, it is not advisable to use this
function with folders that contain a big amount of files, as this will slow
down the audio pick up process.
● Post-it (.txt, .htm and .html files). Command that opens a window,

showing the contents of the text or HTML file.

● Executables and scripts (.exe y .bat files). Command that runs the exe or

bat file.
● Load events command (.evt command). Loading another event file clears

the current event list replacing it with events specified by the event file
loaded.

● On-line radios (.stream files). Plays the sound of an on-line radio station.
● Satellite connections (.satcon files). Enables the line in of the sound card

specified in the options dialog.

● Satellite disconnections (.satdis files). Mutes the line in of the sound card

specified in the options dialog.
● Enable the DTMF detector (.dtmfon files). Enables the DTMF tone

detector.

● Disabled the DTMF detector (.dtmfoff files). Disables the DTMF tone

detector.
● Enable LPT control (.lpton files). Enables remote control through the

parallel port.
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● Disable LPT control (.lptoff files). Disables remote control through the

parallel port.
● Enable serial port control (.comon files). Enables remote control through

serial port.

● Disable serial port control (.comoff files). Disables remote control

through serial port.
● Enable voice tracking (.enablesweepers files). Enables voice tracking.
● Disable voice tracking (.disablesweepers files). Disables voice tracking.
● Advertising

block (.commercial files). Plays an advertising block
generated by ZaraTraffic application. This kind of item can only be used in the
event scheduler.

How to create a new list
1. Press

and select New in the pop-up menu to create an empty list.

2. In order to add items to the list, press
on the tool bar. This will open a
window from which files can be selected. Standard Windows operations are
allowed here for selecting more than one file at a time by using either the Ctrl
or Shift key. When pressing the arrow next to the button, a context menu is
displayed, that allows to insert commands into the playlist.
As an alternative, you can also insert audios by dragging files from the
directory tree below the events list or from any other Windows explorer
window. For that, select a file with the mouse and, without releasing the
mouse button, drag it to the playlist.

Playlist operation
● When the list is in STOP, there is always a track of green color. The green

color indicates which track is going to be played next. Therefore, pressing
PLAY, the track marked in green color will play.

● When the list is in PLAY, there is a track marked red in color. That is the track

currently playing. As above, the track green in color will be next.

At any time you can change which track will be next. To do this, double-click on a
track (unless the option is activated to play immediately with double-click, in which
case it is necessary to open the Media menu to make the change). Otherwise, you
can right-click on the track with the mouse and select Mark as next. This way, the
track will be in green color, indicating that it will play next. Clicking on
the playlist after the current track (colored red) is finished.
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How to save the list
It is possible to store the list in a file, to open it back again later. To do that, press
the button
and select the Save option in the pop-up menu. Then choose the name
you want for the list, as well as its type (LST, PLS, M3U...). If you want to save the
list with another name or type, then execute the option File > Save as... for the main
player or the command with the same name for the auxiliary players context menu.
Besides, keep in mind that the lists created on a computer don't work on another
one, unless network paths are used rather than local ones.

Playlist operation modes
The playlist can operate five different ways. These are selected from the drop-down
box in the tool bar.

● Normal: The list plays sequentially and stops when the last track has

finished.

● Repeat: The list plays sequentially and restarts after the last track has

finished.
● Shuffle: Same as repeat, except it randomly rearranges the list before

playing it again.

● Manual: The selected song plays once and it stops when finished.
● Random: It plays the list in random order, that is to say, the green marker

moves to a track randomly and plays it. It does not ensure that the tracks are
not repeated.

Context menu
The playlist has a pop up menu, which opens by right-clicking the mouse on the
playlist. This is basically a short cut to commonly used items from the menu bar and
tool bars. Simultaneously, the track that is right-clicked is selected for the action
selected in the Pop-Up menu. You can access the following functions through this
menu:
●

Mark as next: It marks the selected audio in green, so that it will be the next
cut played.

●

Play: It starts playback with the selected audio. If another cut was being
played in that moment, it stops it.

●

Rename: It lets you change the name of the selected file in the playlist.
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●

Set voice track...: It assigns a voice track to the selected audio.

●

Remove voice track: Removes the voice track associated with selected
audio.

●

Cue: It allows you to prelisten the selected audio without broadcasting it. To
use this function you need two sound cards.

●

View selection length: Opens a dialog that displays the total length of the
selected audios.

●

Shuffle: Rearranges the list randomly.

●

Copy: Copies the selected audios into the clipboard.

●

Paste: Pastes in the playlist the audios contained in the clipboard.

●

Delete: Removes the selected audios from the playlist.

●

Delete all: Empties the playlist.

Control buttons
You will find under the playlist the buttons that allows to control it. They are the
following ones:

PLAY button. Sets ZaraStudio in PLAY mode, beginning by the
green colored audio.
STOP button. Stops the playlist.
PAUSE button. Pauses the playlist. This button does not work with
satellite commands.
STOP + PLAY button. Stops the current audio and plays the next
one (green colored).
REWIND button. Moves the playback 30 seconds backward.
FORWARD button. Moves the playback 30 seconds forward.
STOP AFTER CURRENT button. Stops playback after the current
item finishes.
TALK OVER button. Reduces the playback volume, and restores it
when the button is pressed again. The amount of change in
playback volume is set in the options menu as is the time to fade
14
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the playback to that level. Look for Talk Over in the options.
LOOP button. Plays the current audio continuously, that is, when it
is finished it is played again from the beginning. This happens until
this button is unchecked or the Stop + Play button is pressed.
AUTODELETE button. When it is pressed, ZaraStudio removes each
audio from the playlist, just after playing it.
Besides, the track bar which is at the right of the buttons allows to change the
audio level of the playlist.

File attributes
Despite not having a database, ZaraStudio can store certain information about audios
in the file name. Such data are:
●

●

●

Overlap. The end of each audio can be overlapped with the beginning of
the next one for a customizable time interval for each cut. This is done by
adding “~overlap” at the end of the file name. However, remember that
this period is only considered exactly when the end of the song detector is
disabled (see Options – Fade). Here, there are several examples:


A file called Id~0.mp3 would be overlapped zero seconds with the next
one.



A file called Song~8.mp3 would be overlapped for eight seconds with the
next one.

Audio start. Some files may have several silence seconds at the
beginning, especially songs ripped from CDs. In order to jump directly to
the audio beginning, you should add “~start-” to the file name. Besides,
you can set the overlap and the start simultaneously, by typing the suffix
“~start-overlap”. Here, you can see several examples:


A file called Song~4-.mp3 would be played skipping the first four
seconds.



Another file named Song~4-9.mp3 would be played skipping the first
four seconds and it would be overlapped nine seconds with the next cut
in the list.

Intro time. Intro time is the period that goes from the beginning of the
audio file until the singer starts singing. In order to set this time, you have
to add “~intro-start-overlap” to the file name. As you can see, when an
intro time is added is mandatory to also set the overlap and start points,
though you can leave them empty to use the default values. See the
following examples:


A file named Song~4-1-10.mp3 would be played skipping the first audio
second, with an intro period of four seconds and overlapping ten
seconds with the next audio cut.
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●

A file named Song~4--.mp3 would be played with a four-second intro
period and with the default overlap and start values.

Expiration date. Some audios, like ads, may have an expiration date,
from which the file mustn't be played. In these cases, you can set this date
in the file name. This way, ZaraStudio won't play expired files and it will
indicate this situation in the log file. Besides, when an expired file is placed
into a folder and that folder is played as a random track, the file is not
considered. expired cuts in rotations aren't played either. The date must be
typed in the format [dd-mm-yyyy], since, if it is not exactly in this way, it
won't be considered or it will behave unpredictably. Here, there are some
examples:


A file called shopAd [12-11-2008].mp3 would expire on the 12th of
November, 2008. That day, it wouldn't be played.



A file called Christmas [07-01-2009]~2-1.mp3 would expire on the 7th
of January, 2009, it would be overlapped for a second with the next cut
and it would be skipped the first two seconds.

5. Events
An event is a file that activates on schedule. Events are a useful way to play files or
to execute commands independent of the playlist. They can be used to program
announcements, actions, etc.

This figure shows the list of upcoming events in the main window of ZaraStudio. The
events display 15 minutes prior to activating.
Above the list of events there are four buttons, whose functions are:
1. Play: Starts delayed events, that is to say, events that have not yet been
started as they are programmed to wait for a currently playing file to end.
2. Discard events: Removes an event held by a delay as described above.
3. Enable events: Activates or deactivates the loaded list of events.
4. Schedule events (clock): Opens a window that allows defining, saving or
loading events.
In order to add events, click on the clock icon. Doing this will open this window:
16
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Each event has a check box that serves to activate or to deactivate the events
individually. Changes done will be saved and the dialog will close when pressing the
OK button.

New
Now, to add a new event, just press the Add event button. Then, we will see the
following dialog:

17
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The user defined parameters of an event are:
● Start date and time

Select the date and time at which the event will play for the first time. The
event will remain active until the date and time of expiration. If the expiration
check box is not checked (default), then the event won't expire.
● Periodicity

Setting date and time defaults to playing once per day. Selecting Play every
hour will do just that. Also, it is possible to program the event to play at
selected hours. Selecting Other hours... opens the following window:

18
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Here you can mark the hours desired. For any of the times (hours) selected,
the minutes default to whatever was selected for the start time.
● Event type

This can be a sound file, but also we can activate play or stop automatically,
insert a random track, a connection via satellite... the satellite command
clears mute of the selected sound card input for the amount of time shown in
the field that is to the right.
● Wait mode

An event can be delayed, immediate or overlapped. Let's see how it behaves
on each case:


Delayed. The event is not played when its start time arrives, instead it
waits until the song that is being played ends. If the program is
stopped, the event will remain in wait until it is launched manually.



Immediate. The event is played at its exact time. If another file is
being played, it will be stopped. On the other hand, if the program is
not playing any file, the event will be played too.



Overlapped. The event is played over the file which is being played in
that moment, reducing its volume to hear the event clearly. This is
configurable in the Talk Over page of the options dialog.

● Maximum wait

Maximum wait specifies how long an event can be delayed before being
removed from the list of events. For example, if a delayed event programmed
to start at 13:15 has a maximum wait of 5 minutes and cannot start by 13:20,
it disappears from the window of next events and it does not play this time.
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Modify
Click to modify one or more parameters of an event. It is necessary to have
previously selected an event in the list. The same action can be carried out by
double-clicking on an event.

Delete
Click to delete one or several events. In order to select several events, hold the Ctrl
key while events are selected at random with the mouse. In order to select a block of
events, click on an event and while holding the Shift key, select the last event in the
desired list.

Delete expired
Events that have expired appear grayed out to indicate this fact. Clicking on Delete
expired will clear all expired events from the list.

Open/Save
These two buttons are to open existing event files or to save the displayed event list
respectively. In any case, when closing ZaraStudio the current list of events is stored
automatically by Windows in the registry and is restored when ZaraStudio is
restarted.

New tab
This button opens a dialog in which you must specify the name of the new tab. After
typing it, a new tab will appear at the right of the last one. If there is no enough
space in the window to display it, two small arrows will be displayed to navigate
through the tabs. Events are always created in the active tab. However, it is possible
to move them from one tab to another. Simply, right-click over the desired event and
select the Cut command. Then, go to the destination tab, press the right mouse
button again and choose the Paste command.
Tabs are useful to group events by themes, avoiding a large events list. This way you
can, for example, create a new tab called “Id”, another one for “ads”,...

Remove tab
A dialog will appear when pressing this button. It will ask you if you are sure you
want to delete the tab, because, when doing it, all the events it contains will be
deleted too.
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Context menus
The events dialog has two context menus, which allows you to access to several
additional features.
●

List context menu. If you press with the right button of the mouse on the
events list, a pop-up menu will appear, that will allow you to make the typical
edit operations: copy, paste, cut, remove and remove all.

●

Tabs context menu. This menu is opened by clicking with the right mouse
button on the active tab. You can create a new tab, remove the current one or
rename it.

6. Options
Clicking on the icon
on the top tool bar, will open the options dialog. From this
dialog, you will be able to manage:
● Audio
•

Fade

•

Outputs

•

Satellite

•

AGC

•

Silence detector

•

Mixer

● Telecommand
•

DTMF

•

Parallel port

•

Serial port

● Log
● Explorer
● Random tracks
● Tags
● Talk over
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● HTH
● Paths
● General

General
It allows you to set several ZaraStudio options:

● Station Name. It is the text that appears in the top tool bar of the main

window.

● Language. Language of the user interface. This option only takes effect when

ZaraStudio is started.
● 'CurrentSong' and 'NextSong' file output. ZaraStudio generates two text

files, one with the title of the song which is being played, and another one
with the following song. You can use them to send them to a RDS coder, to
your web page,... Here you can specify the folder where these files will be
created.

● Enable Autostart. Causes ZaraStudio to automatically play the playlist when

the program is opened.
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● Enable AGC. Enables the Automatic Gain Control, that keeps output volume

at a constant level.
● Open the last list at startup. If checked, Windows remembers the playlist

that was active when ZaraStudio was closed and reloads that list when
ZaraStudio is reopened.

● Shutdown confirmation. When leaving the program, it asks the user if he

really wants to quit the program.

● Play tracks by double-clicking on them. By default, when double-clicking

an item in the playlist, the green marker moves to that item, indicating it is
next up. By activating this option, the track plays immediately when doubleclicked, not waiting for the currently playing track to end.
● Disable the events in secondary instances. When this option is checked,

secondary instances will open with the events disabled.

● Allow opening more than one instance. You can prevent users from

opening several instances of ZaraStudio by unchecking this option.
● Launch the program on system start up. Runs ZaraStudio after system

start up automatically.

Fade

Affects overlapping and fading of tracks. It is possible to have two separate settings
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for each auxiliary player and for the main one. There are two modes of operation:
● End of song detector.

In the last seconds of a track (value determined by the field to overlap tracks)
ZaraStudio will automatically detect volumes below the threshold indicated by
the sliding bar. At that point, the overlap will eliminate the end of a track that
has a long fade out.
● Without detector.

ZaraStudio will fade to the next song based solely on the selected time values.
This will permit the end of a track to play out regardless of the playback level.
By default, the value selected for overlapping applies to all tracks. Nevertheless, it is
possible to give a specific value of overlapping to each song. The file must be
renamed by adding ~overlap to the file name, where overlap is a positive integer or a
float value. For example, in the file Blues~1.mp3, one second will be the overlap
value. When writing decimal values, make sure you are using the decimal symbol
specified in your Windows configuration, otherwise it won't be recognized ( Control
Panel > Regional Configuration of language > Standard and formats > Personalize).

Remember that you can set a different overlap in each file. To do that, you only
have to rename the file, adding at the end of its name the character ~, followed
by the seconds you want the overlap to last. For example, the file
jingle~1.mp3 will be overlapped for a second with the next audio.
Options Fade on overlap and Fade on stop:
● Fade on overlap.

When this option is active, ZaraStudio will fade the previous song whenever a
new one begins. When deactivated, the song overlaps but is not faded.
● Fade on stop.

When activated, ZaraStudio will fade the playing track when Stop or Next is
clicked. Otherwise, playback simply stops.
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Talk over

Here you can set the level to reduce the currently playing track to when Talk over is
activated. Also, time to reduce the level can be set here. These parameters are set
for both voice tracking and the talk over button, located on the bottom tool bar.
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Log

It allows you to configure log files. ZaraStudio stores the time at which each is audio
is played in these files, warning also of possible errors. Prelistens are not logged
(unless an error happens), in contrast to the jingle palette audios. By default, both
the primary and secondary instances write messages to the log file. If you don't want
secondary instances to log, then check the option Log only when using the first instance.
Log files are text files, but with the log extension. They can be opened with any text
editor, such as Notepad. It is generated one log file per day, for them to be easy to
handle. If you want to find a concrete event, you can browse these files through a
tool called Auditor, reachable from the Tools menu.
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Outputs

Select the sound card to use for the Air output, Cue output and the auxiliary players.
If you have only one sound card output, both Air output and Cue output will be heard
together. Please, note that the change takes place when the next file is played.
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Satellite

ZaraStudio lets you rebroadcast the sound present at the line-in port of up to two
sound cards. Audio is routed to air output, when the connect and disconnect
commands are used, or to the player output, when a timer-based connection is used.
In order to achieve this, the application picks the sound from the line-in port, stores
it in a temporal buffer and plays it through the output sound card. The buffer size can
be set through the Buffer size (ms) field. The larger this buffer is, the longer the audio
delay is, but the chance of audio interruptions decreases. A value of 100 milliseconds
is a good choice.
From version 2.2, this feature is available with any kind of sound card, even the ones
that do not allow to enable their line-in port through Windows mixer. However, for
this to work properly, you have to enable the desired channel in the recording section
of Windows XP mixer. The configuration may vary depending on the sound card
model, but, in general, it should be like this:
•

In “Playback” section, all the channels, except “Volume control” and “Wave”,
should be muted.

•

In “Recording” section, all the channels, except “Line volume” and “General
volume” (if exists) should be muted.

You do not have to make these adjustments on Vista or 7, as the operating system
creates an independent device for each sound card channel.
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It is also possible to keep using the previous system based on controlling Windows
mixer. To do this, select the option Control Windows mixer. Then, choose the devices
and channels to use in the dropdowns below. This system has the advantage of not
introducing any delay in the signal, but has the drawback that many cards, especially
the professional ones, do not support it, as they include proprietary applications to
enable and disable the inputs instead of the standard Windows mixer.

Mixer

You can use any Windows application audio sound card mixer. Type in the location of
the mixer program file or Browse for the location. When the mixer icon on the top
tool bar of the ZaraStudio main window is clicked, the mixer application selected will
open.
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Silence detector

Detects periods of silence while playing tracks. When this happens, ZaraStudio jumps
to the next track. It does not activate in the case of a system failure, only when
silence in the playing track exceeds the time selected.
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Tags

By default, in the playlist are the names of the files. Nevertheless, for MP3 files, it is
possible to show ID3 tags. In order to show them, simply check Enable tags. Type the
desired info macros (listed below the box) into the Format box. The tag info
represented by the macros will appear in the playlist in the order listed in the Format
box.
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TTH

Here you set temperature and humidity for announcement. ZaraStudio can import
data from the application Weather Watcher (requires version 5.6 or higher) or you
can manually enter values in the fields Temperature and Humidity. The Weather
Watcher software can be downloaded for free at http://www.singerscreations.com.
To use data from a weather application, check Import from file and type in the file path
to the data file generated by the weather application.
Select the appropriate Units (Celsius or Fahrenheit). ZaraStudio will automatically
convert the weather data to this unit regardless of what unit the data currently is.
A problem that can arise is the loss of the Internet connection, so we would be
announcing incorrect weather data values. In order to avoid this possible situation,
you can make ZaraStudio not announce the temperature and the humidity, if the
application Weather Watcher has not updated the data in a given range of time. To
do this, check the Disable announcements... option and specify the minutes the weather
data will be valid since the last update.

Configuring the application Weather Watcher
1. When opening the application, you will see the following window:
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2. Click on the bottom icon on the left side of the window.
3. The following window will be opened:

4. Go to the Active City tab, if you are not already on it, and press the Add City
button.
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5. The following window opens. Type in the desired city. In this example, we
want to see data for Teruel, so we type "Teruel" and click on Search.

6. Teruel is in the list and we click on OK.
7. Back to the Weather Watcher Options window, click on the Export tab, then click on
Enable Exporter. We must also indicate the file path that ZaraStudio will use to
look up the file.
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8. Now, go to the Auto Update tab and select any value, excepting Never Auto
Update. As a orientation, airports use to update the weather data every 30
minutes.
9. Now, press OK and update the weather data if the program has not updated it
automatically (by pressing the first button at the left side of the window). The
application is now configured. Now we must tell ZaraStudio the path of the file
generated by Weather Watcher, as it has been explained before at the
beginning of this document.
10.Then, check the Import from file option and press Browse to locate the file
specified in Export file location.

Explorer

Allows to configure the root folder of the file tree which is at the left of the playlist, as
well as the file types that will be displayed.
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Parallel port

It is possible to control ZaraStudio with external devices, like a mixer or a satellite
decoder, by using the PC's parallel port. These devices produce pulses or contacts
that fire a specific action when are detected in the computer, like connecting to
another station.
In order to enable this feature, you must enable the Allow remote control through the
parallel port option. Once you have done that, select the port from which you want to
control ZaraStudio.
Now, you have to configure the actions you want to execute when a pulse or contact
is detected in the parallel port pins. This is the pin distribution in the connector:

We are going to use only pins 2 to 9 and pins 10, 11, 12, 13 and 15. The former are
output pins, that is, the computer writes on them, while the latter are input pins, that
is, the computer reads them.
Each pin has two different signal states: high (5 volts) or low (0 volts). A voltage
change from low to high is called a rising edge, while the contrary case is called a
falling edge. ZaraStudio can detect both cases and it carries out the action specified
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by the user in each case. Besides, there are always 5 volts in pins 2 to 9 (this is only
true while ZaraStudio is running) and in pin 25 we always have ground (0 volts).
Now, let's see how to make the physical connection. Suppose we want to connect a
decoder that makes a contact when there must be local programming and the
contrary in national programming. This is a possible way to make such a connection:

Let's see how the circuit behaves on each case:
●

Local programming: the switch at the left is closed, so pin 10 is connected
to ground (0 volts). The pin will be in low level.

●

National programming: the switch will be open and pin 10 will be connected
to pin 2, which has 5 volts, through a resistor, so pin 10 will be in high level.

So, when switching from national programming to local one, a falling edge will be
made (in this case we would select the Disconnection action in the options dialog),
while, on other hand, a rising edge will be made (in this case we will select the
Connection option).
Feel free to contact us if you have any questions about how to connect a specific
device.
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AGC

ZaraStudio has its own automatic gain control DSP (AGC), that allows to level equally
the volume of all audio files automatically, providing your broadcast a more or less
constant audio level.
If you want ZaraStudio to level the sound, check the Enable AGC option and
configure it at your taste. These are the modifiable parameters:
●

Output level: can take values between 0,0 (silence) and 1,0 (0 dbs). This
control allows to set the volume at which files will be normalized.

●

Quiet level: audio level under silence is considered. ZaraStudio won't amplify
the sound under this level.

●

Rate: amplification adjustment rate.

●

Gain: amplification level.

●

Delay: delay in seconds before increasing level.

Please, note that some extreme values may cause noises in the sound. If you prefer,
you can use one of the three predefined presets. You can access them through the
box which is on top of the sliders.
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DTMF

ZaraStudio allows you to synchronize your station with another one which uses DTMF
tones. If you are not associated with any station, disable the detector. On the other
hand, if you want to use this option, enable the detector and configure it according to
your needs. In most stations, the disconnection tone is 69. When ZaraStudio detect
this tone, it will mute the line-in channel and it will do the action selected below: play
the list or play the pending events.
● Pending events: Plays the pending delayed events. When it finishes the

playback, it plays the playlist until the connection. If there are no pending
events, it will play nothing.
● Play the list: Plays the playlist normally (chaining the events if needed) until

the connection arrives.
In order to connect you may choose three different options:
● Tone: Some radios emit a tone to disconnect and another one to connect. If

this is your case, check this option and specify the corresponding tone (it
usually is 90).

● After X seconds: There are radios that choose to set the disconnection time

to a fixed number of minutes. If this is your case, check this option and
specify the duration of your disconnections. Once that seconds have passed
since the disconnection tone was received, ZaraStudio will stop the playback
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and it will open the line-in channel.
● Don't connect or connect manually: In this case, ZaraStudio goes on

playing the list and the events and it doesn't connect to the line-in. Also, it
can be used to make manual connections. Suppose you want to launch a
sequence with commercials and reconnect when it finishes. You could achieve
that by adding a connection to satellite command at the end of the sequence.
If your network disconnections have different lengths, you can use the command
satellite countdown. When this command is executed a count down is started, whose
length is set by the user. While this stopwatch is running, ZaraStudio goes on playing
the playlist or the events normally. When this counter reaches zero, it stops the
playback and it connects back to the satellite. Then, we will show you an example of
how to use this command.
Suppose you a have a three minutes long disconnection in which you have to play
three twenty-second ads. As the commercials don't cover the whole local window, we
will let ZaraStudio fill it with music from the main playlist.
In order to solve the disconnection, we are going to create a sequence with a
countdown command and four ads. To insert the command, go to Playlist > Add satellite
countdown.... We will enter three minutes in the dialog that will appear (00:03:00).
Now, let's insert four ads after the command. Then, we will get a list as the following
one:

Now, save the list as a sequence and schedule it as a delayed event some minutes
before the estimated disconnection time. When ZaraStudio receives the disconnection
tones, it will play the sequence we have just created. In first place, the countdown
will start and, while it reaches zero, the ads will be played. When the sequence is
finished, it will go to the main playlist and will play its contents until the three
minutes are reached. In that moment, it will reconnect automatically.
ZaraStudio also considers the possibility of making local programs, in which you want
to ignore the tones sent by the mother station. When that situation happens, you can
insert commands in the list or in the events to enable/disable the DTMF tone
detector.
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Serial Port

ZaraStudio allows telecommand reception from a satellite receiver through the
computer serial port, without needing a physical relay box device.
This system works through 8 virtual relays, whose state is received from the mother
station by means of the serial port. In order to use this feature, you have to check
the Allow to control the program through the serial port option. Then you must set the port
you want to use to establish the communication:
•

Port: Indicates the serial port number to use. This field allows writing, in
case you need to type a special port number.

•

Baudrate: Speed at which communication will be established. This speed
should be the same as the one set in the mother station to send the
information. Otherwise, reception errors might happen.

Once you have set the connection parameters, you have to select the relays you
want to use. ZaraStudio will ignore orders coming from non-selected relays. This lets
the mother station send disconnection commands on a selective way to a station or
group of stations without the rest noticing.
Finally, you have to choose the actions that will be carried out every time a relay is
closed or opened. There are several options:
•

None. The application will carry out no action.

•

Connection to channel 1. Connects to the mother station by means of
the sound card set as channel 1 and stops local audio playback.
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•

Connection to channel 2. Connects to the mother station by means of
the sound card set as channel 2 and stops local audio playback.

•

Disconnection + List. Interrupts the audio coming from the satellite and
starts the main playlist audio playback.

•

Disconnection + Events. Interrupts the audio coming from the satellite
and starts pending events playback.

•

playlist. Starts playing the main playlist.

•

Events. Plays the pending events.

•

Stop. Stops playback.

Random tracks

This page of the options dialog allows to customize the way in which songs are picked
when using random tracks (Playlist > Add random track...):
●

Do not repeat songs until the whole folder has been played. ZaraStudio
will choose a file from the folder randomly, but it won't repeat any one until all
files it contains have been played. It does not guarantee a file is not played
twice in a row, though it is quiet difficult for that to happen in folders with lots
of files.

●

Separate songs of the same artist. When enabling this option, it won't
repeat any artist until the random track has been played as many times as
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specified in the numeric field which is just under the option. For this system to
work properly, it is necessary to have the files named with the format 'Artist –
Title' (without the quotes). For example, a file correctly named would be
Alicia Keys – No one.mp2.
Ensure minimum separation until repetition. When activating this option,
it is guaranteed that a song won't be repeated, at least, until the random
track has been played as many times as specified in the field just under the
check box.

●

Keep in mind that the more restrictive the selection is, the longer it will take it to do
it and the chances of repetition increase, since in case of some criterion can't be met,
a track will be repeated randomly.
Paths

This windows lets you set the folders that will be used by several modules of the
application:
•

Users database. ZaraStudio uses internally a database to store the users
login information, permissions and profiles. This way, if you place this
database in a network folder, you can share this information with other
computers in which ZaraStudio is installed.

•

Advertising plannings. The purpose of this folder is to communicate with
ZaraTraffic, ZaraStudio's advertising manager application.
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7. The menu bar
File Menu
●

Exit: Closes ZaraStudio.

●

Find in folders: Opens a window that allows file search for a given directory.

●

Full path: Shows the complete file path for files in the playlist.

●

List font: Allows changing the text font used in the playlist.

●

Header in the list: Select to show playlist column titles (song title, length).

●

Song numbers: Select to sequentially number the songs of the playlist.

●

Track bars: Shows or hides the bars that indicate the percentage of audio
which has been played, to avoid accidental alterations or to increase the
available space in the screen.

●

Events and indicators: Shows or hides the panel which contains the date,
the time, the upcoming events and the file tree, to save space in the screen.

●

Main player: Shows or hides the main player, for example, to get more free
space to open auxiliary players. Although it is hidden, if it is in PLAY mode, it
will continue playing the audios it contains.

●

Audio palette: Shows or hides the instant access jingles palette which is at
the bottom of the window.

●

Weather data: When it is checked, it shows the temperature and humidity
information. When it is unchecked, only the date and the time is shown.

●

Update tree: Refreshes the list of files below the list of next events. An
update should be done after changing the content of the hard disk.

Edit Menu

View Menu

Palette Menu
●

Edit palette...: Opens a window that allows changing audio palette
assignments.
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Tools Menu
● Mixer: Opens the mixer application specified in the mixer options dialog.
● Aux players: It allows to open four auxiliary playlists. Each playlist can be

assigned to a different sound card.
● Auditor: Opens a dialog that allows to search data in the log files, as well as

to export transmission reports.

● Voice track editor: Opens a dialog that allows to assign voice tracks to

sound files. For more information, see The voice track editor.
● Options: Opens a window allowing several ZaraStudio program options to be

configured.

● Manage users: Opens a dialog that allows to add new users to the system,

modify permissions of already existing users and delete users that are no
longer needed.
● Change user: Opens a dialog that requests user login information. Then,

loads the window layout and permissions of the logged user.

Programs Menu
● Edit...: It allows to configure a unlimited number of shortcuts to programs.

When executing this menu option, it will appear a dialog where you will be
able to write the data of the program. You will be able to use macros in the
fields “command” and “parameters”. Those macros are:
$(LogDir)

This macro is replaced by the directory where the log files
are stored.

$(NextFile)

This macro obtains the complete path to the track marked
green in color.

$(LogFile)

This macro is replaced by the complete path to the current
log file.

Help Menu
● Contents: Shows this help.
● About ZaraStudio: Shows information about ZaraStudio.

8. The audio palette
The bottom toolbar has 9 buttons that allow quick access to 9 audios. In addition, it
is possible to store up to 10 different pages, allowing quick access of 90 audios.
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There are two ways to activate an audio:
1. The quickest way is to press a keyboard number. For example, to start the
audio labeled "067" (number 2 on the tool bar shown), simply press the
number 2 on the keyboard.
2. Click on the number of the audio in the tool bar with the mouse.
To modify the audio button assignments, there are two options. First, and simplest, is
to drag with the mouse a file from the file tree below the window of next events (or
from Windows Explorer) to the button you want to assign. The other way is to select
Palette > Edit palette.... The following window appears:

To change a button assignment, click on the desired button and click Modify... (or just
double-click the desired button). A window opens that will allow selecting a sound file
to assign to the button. To save the current list of assignments or to open another
saved list of assignments use the Open or Save buttons. Each page of a list must be
separately saved. Change active pages using the drop-down box at the top.
Also, with the Cue button, you can preview the audios (remember a second sound
card output is required to keep the Cue playback separate from the On Air playback).
The pages of the list can have text names also. Highlight the current name and type
in a new one. Click on Rename or press the ENTER key.
Audios have three modes of operation: Normal, Loop and Voice over. In order to change
the mode of operation, you must right click on the desired button. A window opens to
allow
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toggling between those modes:
● Normal: The audio is played normally.
● Loop: The audio will continue to repeat until audio button is pressed again.
● Voice over: Before playing the jingle, it decreases the volume of the main

playlist, restoring it when the jingle has finished.

9. Find in folders

This allows you to look for files in a given folder or its subfolders.
● Find: You must write the text which will be searched in this field. ZaraStudio

will search in the file name and in the ID3 tags TITLE and ARTIST, as long as
it is enabled the search in ID3 tags option.

● Cancel: Cancels the current search.
● Folder: Folder in which the search will be done. You can choose one by

pressing Browse.
● Search in ID3 tags: Tells ZaraStudio whether the ID3 tags will be read or
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not. Please, note that the search is slower when this option is checked.
● Find now: Starts the search process.

Once the search is finished, the list at the bottom will show all the files found. In
order to insert them in the playlist, just make drag-and-drop. Besides, it is possible
to prelisten the files by clicking with the right mouse button on the desired file and
selecting the Cue option. The search is done by using masks, i.e., there is a special
character which means any set of characters: *. For instance, in order to search the
file TheRadio-Id1.mp3, we must write *id1*. It is similar to the command line
window.

10. TTH announcements
ZaraStudio can announce the time, temperature and humidity automatically using
pre-recorded audio clips. These announcements are inserted into the playlist ( Playlist
> Add time announcement) or event lists as commands. For this to work, the audio clips
must be located in the folders Time, Temperature and Humidity created when
ZaraStudio was installed (normally in c:\Program Files\ZaraSoft\ZaraStudio)

Time Folder
This folder contains audio clips of the spoken hours and minutes. There are three
types of files:
● HRSXX.mp3, where XX is the corresponding hour (from 00 to 23). These files

must contain audio clips that say something similar to "It's XX". Example: the
HRS02.mp3 file could say "Time now, 2". This will be followed by the minute
file.

● MINXX.mp3, where XX is the corresponding minutes (from 00 to 59). These

files must contain audio clips that say only the number of the minute.
Example: the MIN53.mp3 file would say "53". When preceded by the hour clip
you have “Time now, 2:53”.
● HRSXX_O.mp3 (the last character is the letter O, not a zero). This file must

contain an audio clip that says something like "It's XX o'clock". Example: the
HRS14_O.mp3 file would say "It's 1400 hours" for 24 hour format or "It's 2 PM
o'clock" for 12 hour format.

Temperature Folder
This folder contains audio clips of the spoken temperature. There are two types of
files:
● TMPXXX.mp3, where XXX is the corresponding degrees (000 to 100, for

example). You only need to have audio clips for the anticipated range of
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temperatures. Depending on whether you use Celsius or Fahrenheit the range
of numbers will vary. For example, the TMP020.mp3 file could say "We have a
temperature of twenty degrees".
● TMPNXXX.mp3, where XXX is the corresponding degrees below zero (000 to

010, for example). The TMPN002.mp3 file could say "We have a temperature of
two degrees below zero".

Humidity Folder
This folder contains audio clips of the spoken humidity:
● HUMXXX.mp3, where XXX is the corresponding humidity (000 to 100). For

example, the HUM035.mp3 file could say "We have a humidity of 35%".

11. Voice tracking
ZaraStudio can play sound files, as well as time, temperature and humidity
announcements over other sound files. This is known as voice tracking.
ZaraStudio has two types of voice tracking:
•

Voice tracks linked with specific audios. Voice tracks are played every time
its associated audio is played. It does not matter what list is opened.

•

Voice tracks linked with playlist audios. In this case, voice tracks are linked
with a specific playlist item. This way, the same audio can have different
voice tracks in different playlists.

If an audio has both types of voice tracks, the second type will be used.

Voice tracks linked with specific audios
In order to use this feature, you have to go to Tools > Voice track editor... After doing
that, the following dialog will appear:
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This dialog displays all the voice tracks. The first column shows the name of file on
which the voice track will be played. The second column displays the voice tracks,
and in the last one, the instant in which the voice track will be played. This way, you
can link music files with presentations.
Every time the audios in the first column are played (in a playlist, in an event,...), the
voice track in the second column will do too. If a file has more than one associated
voice tracks, i.e., if it appears several times in the first column, one of them will be
chosen randomly.
Besides, there are the following buttons:
● Add...: It allows to add a new voice track to the list. When pressing this

button, a new dialog will open, in which you will be able to set the data
corresponding to the columns described above.
● Modify...: It allows to modify the selected voice track. This button opens the

dialog described in the Add button.
● Delete all: Removes all the voice tracks from the list.
● Delete: Removes the selected voice tracks.
● Open...: It allows to import a previously saved voice track list.
● Save...: It allows to export the current voice track list to a file.
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Add dialog

This dialog lets you link an announce with a song. In order to do that, you have to
follow these steps:
1. Select the song over which you want to place an announce or voice track.
You can do this by clicking the button labeled “...” and choosing the desired
file.
2. Set the instant at which the voice track will be played. There are three
options:
a) Play during intro time. If an intro time has been associated with the
song, the voice track will be played during that period, so that the
announce ends two seconds before the singer starts singing.
b) Play just before overlap time. The announce will be played just
before the song ends.
c) Play after X seconds. It allows you to set the exact second at which
the voice track will be played.
3. Choose the announce or voice track. You can do that at the bottom of the
window. It may be a fixed file, a random track or a time, temperature or
humidity announcement.
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Voice tracks linked with playlist items
In order to link a voice track with a playlist item, just select the file on the playlist
and press the right mouse button. A pop-up menu will display:

Then, click on Set voice track.... After that, a dialog like the one described in the
previous section will open. Enter the voice track details and press OK.
If you later want to remove the voice track associated with a playlist item, just open
the pop-up menu and click on Remove voice track.
This not only may be used with specific audio files, but also with random tracks.

Enabling and disabling
Voice tracking can be enabled or disabled globally in the whole application through
the button
enabled.

on the top tool bar. When this button is pressed, voice tracking is

Furthermore, you can automate this task by scheduling commands or by inserting
them into the playlist.
Finally, to easily identify what playlist items have an associated voice track,
ZaraStudio will show their description in blue color.

12. Templates
Templates allow you to define random music programmings. This way, you can set
the music styles you want to play, how often jingles are going to be played,...
A template is made up by a sequence of random tracks and/or specific audios in a
certain order. When a template is loaded, ZaraStudio adds audios to the playlist
automatically, following the template pattern. If it finds a random track, it adds a
random audio from the specified folder; if it finds a specific audio, it will be added
directly. As the player plays the inserted audios, the application adds more at the
end, generating an infinite playlist.
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Template creation
The process of creating a template is similar to creating a conventional list, so this
task can be done in any player. The following image shows an example of a template
consisting of random tracks, though it is also possible to insert specific audios or
even voice tracks.

Once it is created, you only have to save it. The saving process is the same as for a
conventional list, except you have to choose the TPL file type in the save dialog, as
shown in the following image:

Template loading
You can load a template in a player in one of three ways:
•

Manually. In this case, you have to select Open template... in the
of the player.

•

Through an event. Templates can be loaded automatically using an event
associated to a TPL file.

•

Through a playlist. Inserting a TPL file in a playlist, will make the
template load when the player reaches that item.

menu

Once a template is loaded in a player, ZaraStudio will add audio files to it
automatically, following the pattern specified by the template.
In the following image you can see how a player looks like after loading the template
created in the previous section:

53

User manual

ZaraStudio

13. Auditor
In order to open the log browser, execute the menu option Tools > Log browser... After
doing that, the following dialog will open:

With the auditor tool, you will be able to know at what times a file has been played,
in a given range of dates. Besides, you will be able to export your search in TXT
format, to give transmission reports to your customers. You have to specify the name
of the file you want to look up in the File field. It is not necessary to write the full
path of the file. For example, if you want to look up a file named
c:\ZaraStudio\spots\spotZaraStudio.mp3, typing spotZara would be enough.
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Furthermore, you can filter your search by event type or player:
● File: It allows to look for the specified file, within the log files.
● Errors: It allows to look for all the errors such as broken files, missing files,

and so on.
● Warnings: Limits the search to warnings, such as event deletion because

maximum wait has been reached, song repetition in random tracks,...

● Start up: Looks for the times at which ZaraStudio has been executed.
● Shutdown: Looks for the times when ZaraStudio has been closed.
● All: It displays the full content of the log files, in the given range of dates.

Besides, you can limit the search to a specific player. Some events, like startups or
shutdowns, are not linked with any player, so they will always appear, regardless of
the chosen player.
After choosing what you want to find, you must choose the range of dates in which
the search will be done. Then, you can start the search by pressing the Search button.
Once the search has finished, the results will be displayed in the list.
Then, you can save the list in a file by pressing Export.... Besides, you can export it in
CSV format. It is a text file, compatible with most calc sheets programs, like Excel or
OpenOffice Calc.

14. The auxiliary players
ZaraStudio has four auxiliary players with almost the same features as the main
playlist. In order to open this players, you have several options:
● Execute
● Press

Tools > Aux players > Player 1..4.

Ctrl+1,..., Ctrl+4.

● Press the buttons 1 to 4, that are in the top toolbar.

After doing one of the steps described, the auxiliary players will appear anchored at
the right side of the ZaraStudio window. These players looks like this:
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Its use is similar to the one of the main playlist (see playlist and main window). The
only noticeable difference is that events are not chained between the auxiliary player
items. So, when letting ZaraStudio playing an automatic programming, we must use
the main player, while the auxiliary players are indicated for manual use.

15. Users and permissions
User management
ZaraStudio has a user management module, what not only allows to limit access to
certain application modules, but also to provide an independent window configuration
to each user.
In order to access to this module, you have to execute Tools > User management. After
doing this, the following dialog opens:
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By default, the application has two predefined users that cannot be removed, to
prevent the program from running out users:
•

Default. This is the default user used by the application when it is opened.
It is a user with very limited permissions, so it does not have a password.

•

Admin. This user has administrator permissions, i.e., it can access to all
the application modules. It is not an independent user, but it provides this
access condition to the current user. The default password is “admin”, but
you can modify it at any time.

This dialog also has the following buttons:
•

New: Opens a window that lets you create a new user and assign
permissions.

You have to fill out the following fields:
◦

User. It is the name used to log-in in the application.

◦

Password. Password used by the user to log-in in the application. You
have to type it twice, to avoid spelling mistakes.

◦

Current user as administrator. When this box is checked, a special
user is created. This user gives full permissions to the currently logged
user, regardless of its access condition. This is useful, for example, to
modify the window configuration users that do not have this permission.

In addition, the Permissions tab allows to assign to the user the desired
privileges:
◦

Save list. Allows the user to save changes made to the opened
playlists.

◦

Modify list. Allows to change opened playlists (pasting audio files,
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dragging files from other windows, moving audio files,...).
◦

Change list mode. Gives access to the playlist mode dropdown.

◦

Schedule events. Lets the user access to the event scheduler.

◦

Enable/disable events. Allows the user to enable or disable event
playing.

◦

Play pending events. Lets the user play manually the pending events.

◦

Discard pending events. Gives the possibility to remove the pending
events.

◦

Auditor. Gives access to auditor tool.

◦

Voice track editor. Allows to access to the voice track editor.

◦

Options. Gives access to the options dialog.

◦

Minimize ZaraStudio. Lets the user minimize ZaraStudio's main
window.

◦

Close ZaraStudio. Offers the user the ability to close the application.

◦

Manage users. Gives access to the user management window.

◦

Modify window configuration. Allows the user to customize the
window layout. If this permission is not set, the windows will be blocked
and the user will not be able to move or close them. New windows will
not open either. To modify the window configuration, an administrator
account will be needed.

•

Edit: Allows to modify the password and permissions of the selected user.

•

Remove: Removes the selected user.

User change
To log in as another user, select Tools > Change user. After that, the following
authentication dialog will open:
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You will have to enter your user name and password in this window. If the
information is correct, the window configuration of the user will be loaded and the
application modules to which it has access will be enabled. When the program closes
or another user logs in, the window layout will be saved.
By default, two users are included: default (without password) and admin (with
password “admin”).
Every time, the status bar will display the currently logged user name:
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